| IBM Software Group

Add Your Own Tools to IBM WebSphere
Development Studio Client for iSeries:
Eclipse Plug-in Development

iSeries A Development Team: IBM Toronto

'R TN software

o~ _
£ £} buginess soltware

Add your own tools: Eclipse Plug-in Development © 2003 IBM Corporation

This presentation explains how to extend IBM WebSphere Development Studio
Client for iSeries to add your tools.
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What is Eclipse?
= Eclipse is an empty slate: ‘jl
— Except for the Java tools it supplies -

— Use it to build AD products

— By writing "plug-ins" that offer tools for particular programming
needs

— Plug-ins "snap into" Eclipse seamless
— Eclipse + useful plug-ins = product
— Common base for all new IBM AD products
— Common base for many new 3rd party products

= Eclipse is an opportunity
— To build and sell plug-ins for all eclipse users
— All users of Eclipse and Eclipse-based products

4 © 2003 IBM Corporation

So what is Eclipse? With the exception of the built-in Java tools, Eclipse itself is not
that interesting. It only gets interesting when you add to it some plug-ins (for
example, tools) that do something interesting.

An Eclipse-based product is Eclipse plus a number of interesting plug-ins. IBM is
building numerous such Eclipse-based products, including as we have seen Site
Developer and Development Studio Client. Further, because Eclipse is free and
business partners are free to include it in their products, there will be many other
Eclipse-based products from other companies too, including Rational and
TogetherSoft.

For business partners or software developers who write and sell application
development tools, Eclipse is a fantastic opportunity. By writing plug-ins for Eclipse,
those plug-ins can be sold to any developer using any product based on Eclipse or
even just the raw Eclipse as downloaded from www.eclipse.org. This opportunity is
not lost on iSeries tool vendors, who are all looking at offering Eclipse plug-ins for
their tools. This will result in a rich offering of third party plug-ins for developers to
choose from, all of which extend their core Development Studio Client development
environment. One community, one core development platform, many IBM and 3rd
party tools. This is community and excitement!
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Eclipse Open Source Organization

*An open source community chartered to
manage the evolution of an open application
development integration platform e
=T An Open,
i Extensible Tools

*Managed by an independent, multi-vendor Integration Platform

organization

License Technology
Contribution

* Technology licensed via the Common Public IBM i

*Based on Java with initial support for Linux &
Windows

feclipse

*Broad Industry Support

www.eclipse.org

© 2003 IBM Corporation
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Eclipse was developed by IBM and donated to the open source community. That
donation is estimated to be worth $40 million. Anyone can download Eclipse for
free, including the source code, from www.eclipse.org. Eclipse has generated
extraordinary excitement in the development community and the tools community. It
is written in Java, and can be extended by tools that are also written in Java. These
tools are known as plug-ins. Out of the box, Eclipse offers an integrated
development environment (IDE) that has built-in support for teams and projects and
a robust and revolutionary user interface framework. It also has tools built-in to
create Eclipse plug-ins. Further, there are extensive and very powerful tools built-in
for developing Java applications with Eclipse. So, if all you want is the world's best
Java toolset, then all you need is Eclipse. You can't beat the price!
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Eclipse Workbench

Java Type Hierarchy

E=EPIug-in Development
[ Resource

R . 3 Soripts

A personalized, extensible Ty server
development platform organized via %If:;

developer T el ccietaut)

"Perspectives"

A 'Portal-like’ Tool Integration Platform

"/'/ o7 Products built Tt
with Eclipse
inherit these
capabilities plus
'plug-ins' built
by others

Debugging
Services

Plug-in Services & Tools

Desktop & Help
dinNewo
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Some of the common services Eclipse supplies include: the Java integrated
development environment (IDE), project management, debug, plug-in frameworks,
desktop and help frameworks, and resource managers.
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Eclipse — Broad Industry Support

Over 135 companies have been involved in the Eclipse project,
including these industry leaders ...

*Altoweb *Neuvis «Aldon . !
*Bowstreet +QSSL +MKS [’e chi pse
*BrowserSoft *Rational +Softlanding

*CommerceQuest *Red Hat eLansa www.Eclipse.org
«Computer Assoc. *Serena «ASC

«Compuware *Sitraka

«Crystal Decisions +Skyva "This has long been a dream of developers,

and now IBM is providing the integration

«Embarcadero «TeleLogic framework to make it possible.”
Arun Gupta, CTO, Neuvis Software

*Holosofx *TogetherSoft

2oal "The goal of Eclipse to provide a seamless interface where
* Instantlatlons -Versant developers can leverage tools from multiple vendors is a great

idea and is something that will add value to our customers.
. Legach '{ersata Eclipse is a great way to make it easy for iSeries customers to
integrate and leading tools like
weemeaia NOT @ COMplete
«Merant Iist' | Bill Benjamin
-n Vice President, Business Development
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IBM is not alone with Eclipse. The open-source consortium that oversees
contributions made to it include a number of large companies, and that list is
growing. Note that MKS is an iSeries tool vendor. See www.eclipse.org for the
latest list.
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WebSphere Studio Workbench

=Basis of all next-gen IBM AD products. Eg:
— WebSphere Studio Site Developer
— WebSphere Studio Application Developer
— WebSphere Studio Integration Edition
=Available to IBM Business Partners
— Via IBM PartnerWorld for Developers
v'To build/test plugins
v'To create products

WSADIE
WSAD ..,
Each product is a WSSDA ]
different "configuration" WSWB +EJB
of WebSphere Studio _ XML s
»Refers to product family ecllllse Wb .
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Here you see that Development Studio Client is based on WebSphere Studio Site
Developer, while Development Studio Client Advanced is based on WebSphere
Studio Application Developer.

The Workbench is based on the open-source Eclipse technology about to be
discussed. It is not for sale, but is the basis of all IBM WebSphere Studio products,
and is available to business partners.

Site Developer is IBM’s entry level offering based on eclipse, and it is for building
dynamic Web sites out of non-EJB Java. Application Developer extends Site
Developer and adds support for EJBs. Application Developer-Integration Edition
extends Application Developer and adds support for JCA Connectors and for
Workflow. Enterprise Developer extends Application Developer-Integration Edition
and adds support for S/390 and Enterprise Generation Language (EGL), the follow-
on to VisualAge Generator.
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WebSphere Studio Workbench (WSWB)

A fundamental change in AD Tooling paradigm

00l ool *Challenges

= Difficulty of integration

FUTELI = Different Semantics, Ul etc

= Different repositories
= Not best-of-breed Tool Services

Teol
Services

=Benefits

= Difficult to manage
= Slow to Market

= Easier integration
= Single view/mgmt
=Common look and feel

» Best-of-breed Tool Services

= Tool builder focus on tool functions
= Fast to Market
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New WebSphere Studio Site Developer

*For professional developers of dynamic Web applications & sites

xDelivers integrated support for open Web standards, including Java,
JSP, XML, Rich Media & Web services tools

Web Services & UDDI

Team Support

Web & Rich Media

Integrated WebSphere Server
Studio Workbench

1 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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New WebSphere Studio Application Developer

*For professional developers of Java & J2EE applications, requiring
integrated Web, JSP, XML & Web services support

*Advanced tools for code generation, performance tuning & quality

*Includes a highly integrated WebSphere Application Server test
environment and deployment automation tools

12 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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New WebSphere Studio Integration Edition

*For developers & integrators of advanced J2EE & Web services

*RAD tools for visual application modeling, composition & adaptability (e.g.,
business rules)

*Advanced EAI tools for generating adapters & dynamic microflows
including integration of remote host assets

<~ Visual Builder for Adapters
& Microflow

\) Visual Modeling & RAD

Application De

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Workbench

eclipse.org

= Perspectives
— Contain views and editors

— Are named and have default layout of the views/editors

— Are targeted towards a specific type of development, i.e. Java, XML,
Help, Debug, WebFacing, ...

= Editors

— That open, edit, save and close files

— Can contribute to the Workbench menu bar and tool bar
= Views

— That display information

— Can have their own toolbars

— Updates saved automatically
Miscellaneous
— Actions, Menus, Toolbars, Wizards, Properties, Preferences

15 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Workspace

= Workspace is the term given to refer to all development resources
currently accessible in the Workbench

= Eclipse Resource Workspace
Resources = Projects + Folders + Files
Projects map to a folder in local file system
Projects contain folders and files
Folders contain folders and files
Projects are typed
Resources are versioned as they change

User can compare and restore versions » I
Resources can have properties eciipse
Properties are displayed in the properties view

16 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Workbench Overview Global tool bar
ad menu bar

& XML - WebSphere Development Studio Client Advanced Edition for iSeries o =]
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The Eclipse workbench has four open perspectives. You can see them lined up on
the left frame of the workbench. The current active perspective is the one whose
icon is indented, which in this case is the Java perspective. To open a new
perspective, you use Window->Open Perspective giving you the Select Perspective

dialog that you saw previously. This particular perspective has a Package Explorer
view which drives the Editor and the Outline view.
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. =
; ] Start by opening a
Using Eclipse i g= =
g p perspective based on the B
B 38va Browsin
type of development they e o ey
are working on. < Plug-in Development
(D) Profiing
Hew EZBRemote System Explorer (default)
e B e %Resuurce
a Server
Select 2 wizard ﬁ Oweh
g webFacing
--g:\:mﬂ.m Test g‘r;:::n::; EH ; LI
2 E?'Pudmu:
T G oo e
ik e | Then create new resources
Pl in Develozment (@ saurcs Folder ) .
Rt T (projects, files and folders)
T sabee using the “New” wizards
[ Web ,—w
WehFaring T =
Wb Servies
e
[+ Examplas & TradeTukorial -
& WHOLESALE Database
. . = 1‘; =MLEditProject
Work with your resources using the (o e
_...| Navigator view. The Navigator view shows phasecrte
all resources. Often it is easier to use a ) HewFle.xl
local view which filters out projects that are [ SR
not related. For example the “Packages FHE suiiontoe
view” shows only Java projects. et ] -
1&# =MLTransformProject -
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Eclipse Team Support

» Users create and work with projects
— Contain folders and files

— Which are versioned as they change
— Are “typed” and have type-unique toolinﬁ

— Are synchronized between local workspace and team
repository

B B

\ 4

synchronize

— B B =2

Eclipse Workbench

Team Repository

= |
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Central to the Eclipse integrated development environment is support for projects.
Projects are simply a grouping of folders and files.

Plug-ins have types, such as Java or Web or XML. Tools that plug into Eclipse can
define their own new project types. Tools that plug into Eclipse work against
resources (folders or files) within projects. They can be scoped to projects of a
particular type, if appropriate.

All projects, regardless of type, have common behavior and support. This includes
the ability for a team to share a project by using an Eclipse-supporting software
change management (SCM) product such as Concurrent Version System (CVS) or
Rational Clearcase. This SCM acts as a central repository for one or more projects.
Each team member can easily keep their local copy of any project "in synch" with
the central repository copy. CVS is a free open-source SCM. It runs on Linux, UNIX
and Windows. It comes on the Linux distribution CDs for iSeries Linux LPAR.

All IBM SCM vendors for iSeries are enabling, or have enabled, their products to
Eclipse.
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Plug-in Development
» You add functions to the Workbench by developing plug-ins

= Plug-ins

— Highest level of organization / structure for adding functionality to the
Workbench

— WebFacing plug-in

— Remote Systems Explorer plug-in

— Web Tooling plug-in

— iSeries extensions to Web Tooling plug-in

— A collection of files which implement your desired function

— Plugin installed by copying your files to a subdirectory of
<root>/plugins
— There are built in tools for installing new plug-ins
— Described by the plugin.xml file

— Eclipse will look for this file in all subdirectories of <root>/plugins

— Describes what function(s) your plug-in is adding to the
Workbench

% |
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Anatomy of a Plug-in

22

= Files typically found in a plug-in

<root>/plugins/com.ibm.example/

plugin.xml - describes the plug-in
plugin.properties - translatable strings for plugin.xml
example.jar - Java code for the plug-in
example.properties - translatable strings
HelpContexts.xml - structure for F1 help
doc.properties - translatable strings for help
doc/ - plug-in documentation
*html
nl/ - NL versions of .properties files
en_US/
icons/ - graphics files for your plug-in

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Example Anatomy of a Plug-in
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Plugin.xml File

= An XML file that describes:
Prerequisite plug-ins
Jar files shipped with your plug-in
Extension points implemented by your plug-in
Declares new extension points added by your plug-in

= Required for every plug-in
= Special plugin.xml editor included in the Eclipse plug-in development

environment

© 2003 IBM Corporation
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Extension Points

= Allow you to add functions to the workbench
— Declared in the plugin.xml file
— Associated Java code is shipped in JAR files

— First you need to find the extension point for the new function you want
to add
— Workbench extension points are documented in the online help
— Includes the XML DTD for the extension point and example XML
code

© 2003 IBM Corporation
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Rapid AD Web | |ﬁ|nev Too|| Plugin Dev
. Env
Tool JDT,
Tools ooling (JDT) (PDE)
Standal
Tool
Desktop
—0-
Platform APIs / Extension Points
Common Services Common Frameworks
*Resource Management *Widget Toolkit
Published *Project Model *Ul Frameworks
Extension *Team Programming Model <Editing Frameworks
Points -Debugglrjfg *Builders, Markers, Help
o000 *Extensibility framework N
¥
IBM / ISV s —
Contribution Interface Interfaces, WebDAV
Ba_lse | Repository
Eclipse
Workbench
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Example Extension Points

27

searchi [ | [E0] Advanced search

Contents o

Tool developer information

[E 700l developer information
= [ Extending the platform
(B Programmer's Guide
= B Reference
(@ ap1 Reference
=) (B Extension Points Reference
(@ Platform Runtime
B warkspace
(@ workbench

Other Reference Information
1B Examples Guide
B Questions Index

[ Extending the Java tools
1B Plug-in Dewelopment Environment

[ Help System Example
Bl GEF Developer's Guide
(B orawzD Developer's Guide

Workbench

org.eclipse. ui.acceleratorConfigurations
org.eclipse. ui acceleratorScopes
org.eclipse ui acceleratorSets

org. eclipse. ui. actionDefinitions

org eclipse ui actinnSetPartAssociations
org.eclipse ui actionSets

org.eclipse ui decarators

org. eclipse. ui. dropActions

org eclipse ui editordctions

org.eclipse ui editors

org.eclipse. ui.elementFactaries
org.eclipse. ui. export¥Vizards

org eclipse ui importWYizards
org.eclipse uimarkerHelp

org.eclipse. ui. markerResolution
org.eclipse. ui.neviWizards
org.eclipse.ui perspectiveExtensions
org.eclipse i perspectives

Documentation for

Workbench extension

points is available in
the online help under
Tool Developer
Information

org eclipse. Ui TE
org.eclipse. ui preferencePages
org.eclipse ui projectiNaturelmages
org.eclipse ui propertyPages
org.eclipse. uiresourceFilters
org.eclipse. ui startup

org.eclipse uiviewActions
org.ecligse. i views

org.eclipse. ui.workingSets

Add you own tools | Eclipse Plug-in Development

Add your own popup
menus to the
Workbench
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Extension Point Documentation

&P Help - WebSphere Development Studio Client Advanced Ei o =]

searchi [ ] [0 advances search

Contents {5} | Tool developer information Pe= =3

oper information = .
e o Export Wizards
rammer’s Guide

Erence

Ideniifier: org eclipse w exportWizards

AP Reference

Extension Points Reference

b B Platform Runtime Descripgion: This extension point is used to register export wizard

b B workspace wizards appear as choices within the "Export Dialog', and are used | DTD descri ption for
B workbench from the workbench
B org.eclpse.ui acceleratorConfiaurs the XML to declare

B ora.eclpse.ui.accelerator Scopes Wizards may opticnally specify a description subelement whose bo, i i H
IR orgecipee i accclratariets y eptionally specify P the extension point in
text about the wizard

B ora.eclpse.i. actorDefintions your plugin.xml file

B org.eclipse.ui.actionSetPartAssocia

B org.eclipse ui, actionsets Configurarion Markup:

B org.eclipse,ui.decorators
<!ELEMENT wizard (description? selection®)>
<!ATTLIST wizard

B org.eclipse.ui.dropactions

B org.eclipse.ui.editorActions
id CDATL HREQUIRED
name  CDATA $REQUIRED

B org.eclipse.ui.editors
org.edlipse.ui. slementFactories
class CDATA #REQUIRED
CDATA HINPLIED

], B8, i, B A0t e 28
B org.eclipse. ui.importwizards

B org.eclipse.ui.markerHelp

B ora.eclipse. ui.markerResolution
B org.eclipse.ui.newsizards

B org.eclipse.ui perspectiveExtensio
B org.eclipse.ui.perspectives

B ora.eclipse. ui. popupMenus

B org.eclipse.ui.preferencePages
B org.eclipse.ui projectMatureImage:

>
<!ELEMENT description (#PCDATA)>

) Actual XML
id - a unique name that will be used to identify this wizard.
« name - a translatable name that will be used in the dialog box to reprd examp'QS are

wizard.
class - a fully qualified name of the class that implements shown farther
down the page!
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Hello World Plug-in Example

= Create a new plug-in project
= Examine the Plug-in Development perspective
= Add a menu and menu item to the main menu

= Supply an action for the menu item that displays a message box

29 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

Now lets walk through an example
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Creating a new Plug-in Project

Select

Create a Plug-in Project

Mew Plug-in Project

Plug-in Project Name

Select the riame of the new plug-in project (e.g. ‘com.example.scyz’). By defaul, this
name will alsa be used Far the plug-n 1D,

Ll

-~ Component Test
- Data

<> Fragment Project

EE 4] Extension Paink Schema
ks 'JS;E?S 4 Convert Java to Plug-in Projects
[;J ¥ Feature Project

ava

Plug-in Development
- Riemote File Transfer
o SErVEr

simple:

Symptom Database
- Web

- WehFaring

Web Services

et Use the "New" wizard
#-Examnples

’ to create a new
Plug-in project

Praject name: | com.example.MyPlugin

Praject contents:
¥ Use default

Directory: [ CHDacuments and Settingstyantai|Mly Documents\[EMindscinorkspas  Browse...

By convention your plug-ins
should start with the reverse of
your Internet domain name.

For example: com.ibm...

= Back Cancel

[ me» | Eosn |

cgack [ wexta | Eien

Cancel
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Creating a New Plug-in Project

Mew Plug-in Project

Plug-in Project Structure

Define essential plug-in structure settings

Plug-in Id

[ Eam.example. MyPlugin

Mew Plug-in Project

Plug-in Code Generators

Select the wizard that will generate the intisl plug-in code:

Ll

Javabuider output  [bin

Plug-in puntime library [ MyPlugin jar

Source foldsr [src

" Creats a blank plug-in project

% Create a plug-in project using a code generation wizard

Awallable code generation wizards

9N Custam plug-in wizard

ENDefault Plug-In Structure

5N Hela, World

% Plug-in with a multi-page editor
3% Plug-in with an editor

ZNPlug-in with 5 popup menu

N Plug-in with & property page

% Plug-in with & view

N Plug-in with perspsctive sxtensions

This wizard ereates standard plug-in
directory structure and adds the following:

® Action set, This template creates a
simple action set that adds Sample
Menu to the menu bar and a butkon to
the tool bar, Both the menu itkem in the
et menu and the butkon invoke the
same Sample Action. Its role is to
open a simple message dialog with a
message of wour choice.

Extensions Used

* org.eclipse.ul.actionSet

= Back I Mext = I Eirish

I

Cancel
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Creating a New Plug-in Project

New Hello World plug-in pr

New Hello World plug:

Simple Plug-in Content Sample Action Set
Enter ths required data ko generats initial plug-in fles This template wil generate & sample action set extension with & menu, & menu lkem
and a kool bar butkon,

Plug-in name | MyPlugin Plug-in

Java Package Mame: | com.example, MyPlugin actions

Yersion [1.00

fction Class Mame: | Samplection

Provider Hame | EXAMPLE

Message Box Text: | Hello, Eclipse world
Class Name

| com. example. MyPlugin MyPluginPlugin [V Add the action set to the resource perspective
[¥ Generate code For the class

Plugrin code generation optian:

¥ add default instance access
[¥ Add support Far resource bundies
¥ add access to the workspace:

< Back net> || Ensh | cancel

ek peis [ Emsn | cancel
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Plug-in Development Environment Plug-in

4P Plug-in Development - WebSphere Development Studio Client Advanced Edition for iSeries

T T development

| Plugin project |5 -%-[l® [ e e & [T [| 5 [ %- perspective

f\hpackage Explorer v x W X I J] SampleAction. java

5 . . =
mloW e o MyPlugin Plug-in = ;"E‘mme
@ | [E-BF com.example. MyPlugin - ) ErviEw
oG8 o #lerts and Action Ttems I A | =] Dependencies
J - T E g
R -3 com.example MyPlugin| | Mo alerts at this ime. p ug | n Xm ;u; org edipse.core.|
=] [ MyPluginPlugin.jav. . a ’g) srg‘ec“pse'“‘
untime
) =-E3 com.example. MyPlugin General Information EdltOI’ Ml MyPlugin jar
[4] Sampleaction.javal| T - - " = — S
s This section describes general information about this  The Following ibraries wil be added ta th Extensions
(Eh ECLIPSE_HOME/pluginsford | plugin classpath of this plug-in: T Lo org.eclpse.ulad
£ {2h ECLIPSE_HOMEjpluginsior - o
Plug-in 1d com.example. MyPlugin Wl HyPlugin.iar Mare. i = org.eclipse.ui.per

{Eh ECLIPSE_HOMEjpluginsjor

=+ {Eh ECLIPSE_HOMEjpluginsfard | Plugrin Name Extension Poirts
{Eh ECLIPSE_HOMEfpluginsfarg | Version
{gh ECUIPSE_HOMEIUSory | i ome
[ JRE_LIE - D:\Program Files The Following plug-ins must be installed F__|

G2 icon Class com. example MyPlugin MyPluginPlug | this plug-in to work properky:

. e 3> org.ceclipse.core resources [More,
Implementation F—— % argeciosau

The follawing extensions are defined in this plug-in:

Of the aCt|0nsetS s“ o= oro.eclpse.ui.actionSets
extension point

Required Plug-ins

Extension Points

the s,.u,r.;m

Welcome {0verwew IDEpEndenUEs |Runtime | Extensions | Extension Paints | Source ) a | »
to provide the D P e ¥~ %)
Propert: | walue [ Tl [ pescription | Resource | 1n Folder ;!
i 1

popup menu

Customized editor pages to help you define
g D extensions, runtime jar files, dependencies, ...

Package Expl... | Hierarchy |Plugns
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Defining the Extension

#Weh - WebSphere Development Studio Client Advanced Edition for iSeries
Fle Edt Mavigate Search Project Profls Run Window Help

\ allEw||E-|[F|A-lLBH5 2 &

|B 2 u a s F=s

AE-—BL|Be-|[F|N&]@] ] -

75 J2EE Mavigator - X XI J] SampleAction.java
e E Extensions
o "
T com. sxmple FyFl -
Sl com.cxample. PO 24 ol extensions Extension Element Children
2 e

[=-E& com.example. MyPlogi O show Full extansion hisrarchy
H [4] MyPluginPlugin, ja
[=-E3 com.example, MyPlogc

[ sampleaction.javz

(&= icons

Eby build. properties

=-TH] menu
0= org.eclipse.ui.actionSets LB separator
i L. Sample Action Set (actionSst) : ]

2= org.eclpse. Ui, perspectiveExtensions

%) org.eclipse. ui.resourcePerspective {pes

cRAdeed| @

Use the “Extensions”

Body Text

page of the plug-in
editor to define your
implementation of an

4 i >
extension po int Welcame | Overview | Dependencies Runtime |Extenzions | Extensian Points | Saurce
[ Properties {88 > x
Fropert | valus =
accelerator

Or use the source
tab to manually enter

allowL abellpdate
class
disabledlcan
enablesFor

Tasks |Links | Thmbnal | Styles | Colors | Servers | Console | Properties |

the XML (ouch)!
I
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Plug-in Build Path

&P Properties for com.example.MyPlugin

Info Java Build Path
tBeanInfo Path

Right click on the
PDE project and
select properties to
get this dialog

al Tools Builders

Build class path order and sxported entries;
(Exported entries are contributed to dependent projects)

avador Location
i~ Java JAR Dependsnicies

% Source | & projects | Wl Libraries 1L Order and Export |

< Project References [ 2 com. example. MyPluginjsrc/

variable that points to the

ECLIPSE_HOME is a

directory where Eclipse
(the workbench) is .

Server Preference [ & ECLIPSE_HOME/plugins/org.eclipse core.resources_2.0.1/r

(e 1 & ECLIPSE_HOME pluginsforg. eclipse.ui_2.0. 2 workbench. jat L‘
[ & EcLIPSE_HOME/plugins{arg. eclipse. Ui winaz_z.0.0/workbe

E’ECLIPSE HOME/pluginsfarg. eclipse. swt.wind2_2.0.2/wsfw Select Al
/ & ECLIPSE_HOME pluginsfarg. edlipse care.runtime_2.0.2/rur Deselect All

[ @ ECLIPSE_HOMEpluginsjorg.sclipse. core.boot_2.0.3/boot.
[ & IRE_LIE - D:\Program Files\IBMiwWebSphers Studioieclips)

s

Jjar files required for
the plug-in to build
(SWT, JFace, ...)

installed. Bulld output Folder:

[ com.example. MyRlugin/bin

Browse. .
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Action Class (Invoked by the Popup Menu)

dp web - WebSphere Development Studio Client Advanced Edi —|o 5||
File Edit Source Refactor Nawigate Search Project Profile Run Window Help
= NERNEREE R actionSet extension point requires
5 - 3] JElae]le|l v (1% the class to implement the
13 J2EE Navigater v x |[mruaneuen RS %|| IwWorkbenchWindowActionDelegate
* Our sample action implemsnts . t rf
# The action proxy will be crea
-1 com.example.MyPlugin = # shown in the UL, Uhen the use Interrace
-G src # this delegate will be created and e=ecution will be
m.example.MyPlugi * delegated to it .
; * @see IWorkbenchWindowictionDelegate
MyPluginPlugin.jas e

|

E
i
@
@
Ty
T
]
L
f

Wi, Libraries
B T Connectar Project
5P DefaultEAR
[+ 128 Demo Web Project
-1 iSeries Java Samples
E

jlﬁ Program Call Pmiectl
4

J2EE Mav.., JSErver C... |J2EE Her...

public class Samplsiction implemen
private IV
P
* The cong]

IWorkbenchiindowictionDslegate {

[rom.example.MyPlugin.actions.5amp

ur sample action implements workbench action delegate. The action proxcy will be created by the
workbench and shown in the UL When the user tries to use the action, this delegate will be
created and execution wil be delegated to it.

*®
public Sam
¥ e Also:

S
*= The action has been activated. The argument of the e
= msthod represents ths 'rsal’ action sitting
= in ths workbench UL

‘{g} Gl x
JFace
MessageDialog
class

* @see IWorkbenchiindowhcticnDelegatetrun .
weo run method(...) is
public void run{Iiction action) { )
MessageDialog. openlnformation( invoked when the
windov . getShell(), P
"MyPlugin Plug-in®, :
"Hello, Eclipss world"): popup menu is
¥
selected
T
asks (6 items) P ow x
E [ 1 [ Description | Resource | 1n Folder | Location [ -
Eroken Link - strutsEGL, UpdateAccoun...  struts-confi...  TradeTutorial/Web Content, ling 40
A Broken Link - jwfprojiservices/Reports,,,  eservices.css  WebFacing Project/Web Co...  ling 21 -

‘Gallery IL\brary | Outline | Web St.. EE | | Tasks IL\H\G | Thumbnail | Styles | Colors | Servers | Console

Writable Insert 1:1
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Testing Your Plug-in

_lol x|
File Edit Source Refactor Mavigate Search Project Run  indow Help
=% - %-o|oasdes 8] <] =-
m Fun ld ) 1 Java Application 25 outline =
(@« o & mn [ 2Remots Tava Applicatian, in iSeries visw N welcame
TeTyT
7 3 Java Application in iSeries Server Overview

B src

=3 com.example. MyPlugin)
B [J] MyPluginPlugin.jav,

FHdeed|d|

l#]e

=-f# com.example.MyPlugin)
+ SampleAction.java
+1-{3lh, ECLIPSE_HOME pluginsforg
+]-{2h ECLIPSE_HOME/pluginsfor
(3 ECLIPSE_HOME/pluginsfor
#1-{gf, ECLIPSE_HOME{pluginisfor
&1-{ehy, ECLIPSE_HOME{plugins/or
+]-{2h ECLIPSE_HOME/pluginsfor
+1-{, JRE_LIE - D:\Program Files|

H-{ icons

build. properties
plugin,xml

7 Connector Project

7 Ta$ Dema Web Project
015 I5eries Java Samples
1| {a# Program Call Project
o test

7T Trade

- TradeTutorial

7% WebFacing Project

Ll

3

Package Expl

|Hierarchy | Plug-ins

<

Al - [2) Dependencies

e
Ju 4 JUnit Test S org.eclipse.core,

Provider Name [Ex|

Class

Mo aler
= orgeclipss i
Run
Ge: & Java Bean / Applet ntime Libraries & unkime
Ml MyPlugin.jar

This section describes general information about this

The Fallawing libraries will be added ta th
classpath o this plug-in:

- [B) Extensions
i org.eclipse.ui.ach

plugin
Plug-in 1d o
Plug-in Name  [11
Wersion (1

1. Select any plug-in project

The fallowing exten|

w=orq.ecipse.uil

= e erlinee i

@ 2. Use the Run As -> Run-time Workbench
menu item to launch a new instance of the

Workbench with your plug-in(s) loaded.

Extensions

welcome | Overview

=] Properties

» Use Debug-> Run-time Workbench to

Propert

Elrfa

debug your plug-in
» Set breakpoints in the Java source editor
before or after launching the debugger

editable
Jast modified
name
path

com.xample.MyPlugin
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It Works!

&b Resource - IBM WebSphere Studio Application Developer

_lol x|
File Edit Mavigate Search Project | Sample Menu Run Window Help
=21 SN
B [ ezl Navigater = > = w x |[ERD X
By Welc\qme to WebSphere Studio
This pggg tells you what yau should know befare you start developing applications with WebSphers
Shudin Annlication Neselaner Click he hinklinhked links ko nerfarm Fhe deseribed kals
&b MyPlugin Plug x| 1.
=] @ Hello, Eclipse world
ar)
ve
th
@) Customizing your workbench
= ¥au tan mawe views and editers around the workbench by dragging their titebars, You can
o= Outline = alsa add mare views to vour current perspective by using indow > Show Wiew.
To reset the perspective to its ariginal state, choose Window > Reset Perspective.
An outling is nat available.
s sreus haws areannsd s nerenecbiie wonean sawe ik sinn Windos s Saws Berensctive i 52
< 1 »
= p P
Brand new copy of ) Tacks (o) TR v x
RN | Pesource [ 1n Folder | Location
the Workbench
running with your
plug-in
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User Interface

= User Interface for plug-ins should be done using SWT and JFace
— Provides the best integration with the Workbench

= SWT is a new Java widget toolkit
— Different than AWT and Swing

= JFace is a Ul Framework built on top of SWT for creating wizards,
editors, views, dialogs, preference pages, ....

JFace Ul Frameworks

Text Viewer Contribution Dialog

Standard Widget Toolkit

Native OS Ul Controls

© 2003 IBM Corporation

39 Add you own tools | Eclipse Plug-in Development




‘ IBM Software Group | WebSphere software

User Interface

= SWT
— Fast
— Native operating system look and feel
— Provides all the common Ul widgets

— Button, Label, Menu, Menultem, ProgressBar, ...
= JFace

— Ul frameworks built on top of SWT

— Provide a higher level of abstraction so you can focus on your
added function, not Ul details

— Provide a common look and feel across all Workbench tools

— Wizards, .., preference pages all look and act the same

— Provides base set of classes you can extend to add your specific
function
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User Interface - JFace

= Text Framework
— Framework for providing source (text) editors
—  Provides support for

— Content assist, syntax highlighting, formatting, ...
= Viewer Framework

— Different types of views into a data model
— TreeViewer, CheckboxTreeViewer, TableViewer, ...
= Contribution Framework
— Framework for adding actions to the workbench toolbar and menubar
= Dialog Framework
— Framework for creating dialogs that interact with the user
— Example classes:
— PreferenceDialog, PropertyDialog, WizardDialog, ...
— Also provides pages for using inside the dialogs
— PreferencePage, PropertyPage, WizardPage, ...

4 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Other Things to Consider

\|ELR TN software
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HELP!!! — Lots of ways to provide help

= Tooltip help
Also known as "fly-over help"

Tooltip is shown when user hovers the mouse pointer over a menu item,
button, entry field, ...

Use the setToolTipText(String text) method on a widget
= F1 key help
Context sensitive help

Typically used to provide a short description of the current task when the
user presses F1 in a view, dialog, wizard, entry field

Set context ids using WorkbenchHelp.setHelp(...)

Eclipse then looks up the context id in HelpContexts.xml
= Full blown online help

You can provide complete online documentation integrated into the Help
perspective

This is full topic on its own

43 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation




‘ IBM Software Group | WebSphere software

Team Extension Points

= Version / Configuration Management
— Allows source management providers to plug into the workbench

— Can be used with by any project in the Workspace without any
additional work

— Java projects, Web projects, iSeries projects, ...

Platform APIs / Extension Points

Common Services Common Frameworks

*Resource Management *Widget Toolkit

*Project Model *Ul Frameworks

*Team Programming Model *Editing Frameworks
*Debugging *Builders, Markers, Help

*Extensibility framework

Open source CVS

implementation of the ¥

VCM APIs is provided s itrtaces, WobDAY
as a reference

implementation Repository
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What about the iSeries?

\|ELR TN software
e, O -
£ £} bnamess
==,
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WebSphere Development Studio V5
RPG COBOL

PDM, SEU

CIC++ | lspA RLU

V5R1 or V5R2
5722-WDS
No-cost V4 Upgrade 5903

Unlimited
L

icenses

iSeries | iSeries | iSeries | iSeries iSeries
Web i
Struts Web ” Projects
Java Debug Web | Service Facing RSE
Trace [Profiling| DB | XML sﬁmr +CODE
+VisualAge RPG

WebSphere Development Studio Client V5

46 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

There is now only one application development product sold by IBM, for iSeries, as of V4R5. This is
WebSphere Development Studio (Development Studio), which includes all four host compilers, all
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere
Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development Studio free
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development
Studio are priced very competitive compared to the combined prices of all constituent products. As of
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can be
purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have all the
modern Application Development tools from IBM. This ubiquity is especially important for business
partners who build and sell software. These Business Partners are now free to build software using
any of the technologies or tools in Development Studio, and can assume their customers will have
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively
raises the lowest common denominator to a level unparalleled by any other operating system.



‘ IBM Software Group | WebSphere software

RPG and COBOL Tools

= Remote Systems Explorer
— For random drill-down or filtered access to remote:
— Library, objects and members in QSYS
— IFS Folders and Files
— Linux (including LPAR), Unix and Windows Folders and Files
Local Folders and Files
— For remote command execution of
— QSYS Commands
— QShell Commands
— Linux, Unix and Windows Commands
— For exploration of Jobs in QSYS
= iSeries Projects and Navigator
— For structured, project-based development
— Local team-sharable project
— Holds source files and source members and save files

— Push action to copy local files to associated library
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Remote System Explorer Perspective

= Manages connections to remote systems
— Where you create and manage connection information
— Connections subsequently used in all iSeries tools
— Start by using the New Connection wizard
— Connection appears in tree view
— Expand it to see "subsystem" -> functional groupings

4 temote System Explarer - WebSphere Development Studio Clicnt Advanced =lolxl
Bl EIr MEvste Search Erojsct Run Wnoow  Help
I=" o | 7=
R 4 s Fadn =
Remote Systen Comeion |
Define connection T ermaton @ |- -E#ﬁtwmﬂv" A cutine ks ot
L= T B e
E' 6 Wi,
Paverkproffe:  [verizs = =3 0 L.
| ol I Remote Systems View:
Commection name: | Cevspren: 5o w A Locd s g N
P = 5 = ok ~Shows all existing connections
= <= |= .
Hask rame: = 3
3 el ~Expand to drill down
Desoiphon: [15eries used for desvaloomant : ‘E‘EJM i . A
W il -Right click to do actions
T ety st rame: (1 3 Werk it abjects)
iy
g Loy lat 1 Froperties [e 2 &
(31§ Lo ibrnies Fropey Toae
ol ke A ¥ Litvares conremed e}
1k Benes Commands Neme iGeries Objects
<ok usts [ e corcel | il offy iseries Tobs Aurber of chren
i T I Fles Part [l
) gl Genes Spacied Fies = ‘Twa =.hsmm| -
.
Rawoss Srstene | Tean Tasks | (6rks . |[Seres ., |[Beres v, Feitou, | Spavie,. |Propertiss B¢ >

) . Subsysem: iSerims Dbjecte
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iSeries Connection Properties

= Use Properties of iSeries E— Ao
Commands to set:
. . . .  Subsystzm Library [ | eoden |
—Library list information o Tubarromon |
—Current library
—Initial command to call v |
—Environment variables Lssbaan|
= All information is applied at
connect time
Qustibrary |useeRE 7]
[nbial command |
Rostore Defauts Apply
ol
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iSeries Connection Subsystems

= Expand a connection in the to see subsystems:

— iSeries Objects

— iSeries Commands

— iSeries Jobs

— IFS Files

5 i
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iSeries Objects
Like WRKXXXPDM. For drilling down on libraries, objects, mbrs
Right click offers wealth of actions like create, rename, delete...
Can edit source members using built-in LPEX or classic CODE
Can create User Defined Actions just like in PDM
iSeries Commands
For creating command sets containing one or more CL commands
Right click and select Run to remote run commands
Results are logged in Command console
iSeries Jobs
For seeing jobs, filtered by number, user ID or status
Right click to do common actions on jobs, such as end or hold
IFS Files
For drilling down on IFS folders and files
Right click offers wealth of actions like create, rename, delete...
Can edit source members using built-in LPEX or classic CODE



IBM Software Group | WebSphere software

P Remote System Explorer - WebSphere Development Studio Client Advanced Edition for iSeries =10]x]
File Edit Source Compile Wavigate Search Project Run Window  Hel -
16~ B0 |-k 7 %-]l25 Built-in Remote Systems
= LPEX Editor N
v x| AoroenR X } utline & x
5 Row 117 Column 1 Replace = 0 Global Definitions &
__.ML—_[ | 1 + 2 + 3 + 4 + 1Py Files =
DSTRCT i 011700 x =l
" <g| ORDENTD :
o EVFEVENT *file.pf-dta 011800 !
Expand a filter to A v I p—— e < 1Tem - Disx
biect ITEM. *file.pf-dta 01z000 L <] DSTRCT: D
See objects s 012100 # Display the prompt for o customer — <2 €STMR ;DL
. g .#File. dspf 012200 c WRITE KEY o
reSuItIng from ORDERS. *file: pf-dta 012300 [ EXFHT FROMFT = s 1
. 012400 c SETON & smeo
. ORDLIN. *file.pf-dta 2 oROERS 1 T
resolution of filter 5 PRIGRDERS il ot 012500 x :
PO 012600 * Clear error indicators <] ORDLIN : D!
{Ely QCLSRC.*file.pf-sre 012700 c EISR ClrError - Data Structures
[E QDDSSRC.Hile.pf-src 012800 = B0 Comstants
Dri [y QDDSSRCP.*File.pf-src 012300 * Process the user's request ... J
Indicaty
Dril down through | & g quzctitvs” [ gidgee £ T T TRET T 2 3 e
I|brar|es, and Ely QPNLSRCP.*flle.pf-sre 013200 & *IN12 CASEQ *0H =0 Main Frocedure
. 1 Eh QRPGLESRE #file. pf-src 013300 [ ChS 253 subrowtines
source files to get 0y QROCONIT.rogle 013400 c B = s
i O DEN TR ol 013500 * 2= ADDORDER
to members 7y PRTORDERR.rpale 3| =]
SLTCUSTR.rpgle iy =
2 -
:g B Verify progrom action completed vith informational ¢ = ADDORDLIN =
rpgle I a4 I »
*Right click on & zoRoEnTR rpds
. g X By ZSLTCUSTR mgls ) iSeries Ervor List - <5105VM2M WFLABZ3{QRPGLESRC(ORDENTR) v x
*file pf-
libraries, objects | El% e et || I emage 5. tocation [ onre... | S
- y . i he name or indicator CUSTLNAME..., 0 72 wFLABZ9/QRP... 5105%...
-6 SLTPARTD. file. dspf 1 |RNF703L LT
and members to []__ STOCK *file. pf-dta i RWF7031  The name or indicator IDATA is not. a S WWFLABZ9/QR] 5108V,
get actions 1 6] Z5LTCLSTD. i, dspf i RNF7031  The name or indicator PARTPRICE .. 0 83  WFLABZ9JORP... S10SV..
T ORDENTRPML*prigrp ||| i RWF71S0  Record STRCD infile STOCK contai.. 0 31 WFLABZI/QR S105V...
o I v '_I i RWF7086  RPG handles blocking For file ORDE... 0 32 WFLABZ9/QR] 5108V, =l
| Remate Systems ITEam Tasks |iSeries Comman. . |iSeries Listings {\Senes Error List J Remote Comma... |Spooled Files | Propertiss |iSeries Job Log
WFLABZ2S/QRPGLESRCIORDENTR) MERTVPE(RP?IIFW =Parts Order Forry - daba entr

Various iSeries specific views for showing additional information.
iSeries Error List shows compile / verify errors
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RSE: Filters and Filter Pools

= Expand a subsystem to see "filters"

Like WRKXXXPDM generic name filters but
Are named and saved

There are some predefined
Such as Library List to see *LIBL libraries in iSeries Objects
Such as popular commands in iSeries Commands

To create your own, right click on subsystem object

Each filter can contain multiple filter strings
So you can list all libraries that start with A and B

= Eventually, you'll have too many filters
Time to turn on "Show Filter Pools" via preferences
Expanding subsystems will then first show filter pools
Filters are grouped into named pools
By default they are added to the single default filter pool
You can create your own filter pools
Then add filters to it
Expand a filter pool to see just the filters in it
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iSeries Objects Subsystem Filters

= Library List filter
Displays library list
Provides popup actions for working with the library list

= Library filters
Specify simple, generic or special library names
Lists all matching libraries, when expanded

= Object filters
Specify simple or generic object names, library-qualified
Library name can be simple, generic or special
Specify simple or generic object types and attributes
Can specify one or more type:attribute pairs (OR operation)
Lists all objects that meet criteria, when expanded

= Member filters
Specify simple or generic member names, lib/file-qualified
Library name and file name can be simple or generic
Specify simple or generic member types
Can specify one or more member types (OR operation)
Lists all members that meet criteria, when expanded
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Remote Systems LPEX Editor

= Remote Systems LPEX Editor
Re-write of CODE Editor for Eclipse

= What it has today:
All base support from CODE Editor, such as:

Alt+L/C/M/D/U/S/J to select/copy/move/delete/unselect/split/join

Select streams, lines, blocks and rectangles (Edit menu)

Command-line for directly entering editor commands

Keystroke recording for repetitive tasks

Compare utility

Rich search, find and replace

Bookmarks and quick marks

Ctrl+L to locate a line

Line-number prefix area

File->Get File to import a file

Filter Selection to only show lines containing selected text
Plus!

Outline view support for ILE RPG and COBOL
Content assist for ILE RPG
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Underlying Model of the RSE

PrOflleS ...............................................
—p | Filter Pools |~
Profiles contain ———> | Filters
enable contain —— | Filter Strings
team contain
support
and ;
effective W Connections
grouping — Subsystems data
—p Filter Pool References
contain

e gLUser Defined Actions
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iSeries Projects Perspective

Create iSeries Create Create
Project Source File Source Mbr

&P iSeries Projects - ' shSphere = «velopmer* _cudio Client for iSeries (=] B3]
Eile Edit Source Comd) [UavidEte - Project Run  ‘Window Help
IS-Baallaads |8 -x-[s]a-[les|amr|ai?
iSeries Project e |iSErias Project Navigator  w X ! bos
) 6 Column 51 Feplace
. . . DHane+++++++++++ETDsFrom+++To L+++10c . Keywor dB++++
Ty || B = WHOLESALE 100300 - =
%J =] E? QDDSSRC ooo4o0 sCOPY grpglesrc, cywsordpr
H CWSTOCK. PF goosoo Dquant 5 Like(Qty)
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Here we see the iSeries Projects perspective, which you can explicitly
open. The primary view is the iSeries Navigator that allows exploration of
all existing iSeries Projects. There are wizards lauchable from the toolbar
for creating a new iSeries Project, or creating source physical files and
source members within an existing project. The iSeries Projects
perspective includes a full copy of the Remote Systems Explorer, as a
view, for your convenience. This allows you to easily work with the
contents of the associated library while simultaneously working with the
local copies of the source within the project.
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New iSeries Project Wizard

Choose
Give your project connection
a name from RSE list
iSeries Project iseries Project Properties
Create a new iSeries project that maps to an iSeries library, % Spedify the iSeries project properties. %
_teen., |

Project name: | WHOLESALE] Connection: [Development System | mew.

Project contents: Associated lbrary: | WHOLESALE] Browse...
¥ Use default
irectory; I C:\Dacuments and SettingstyantzilMy DocumentsiIBMiywe  Browse..,

Specify the connection and library name ko associate with this iSeriss project, The
comniction allows for remote access ko the iSeries host machine. Cods changes
made locally are pushed to the specified remate library, That library is alsa used for
performing builds on the remote host,

Spexify the name and location of the iSeries project being created. An iSeries
project allows for local development, while performing builds on a remate iSeries
host machine.

>

[ >
L ]

<gack [ mexex || Eweh Cancel <gak | wests [[ B | canel |

Identify Associated Library: this
is the target library for pushes
and builds
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Here we see the rest of the iSeries Project wizard. First, give the project a
name. Any name you want! Then select or create a connection (from the
RSE!) that identifies the iSeries with which this project is associated. Also
select the library on that iSeries where the contents of this project will be
pushed to. Also, specify a CL command to call for the "Build" action. If you
don't have such a CL command, enter a dummy value or leave it blank.
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iSeries Project Wizard

-« 4 (1 Program Build Style Configuration
R SRR R

Build style controls how the iSeries

Enter the project’s source fils that contains the COMPILE CLLE and BINC CLLE members that will be

project is built on the remote system uploaded ko buld this project.
Build Source File:
hew [qecsre B
1Serles Project Properties icd Autamatically generate COMPILE CLLE prior to each build
Select and configure the active build styls for this prajsct. e

cnsl_|
Active build style: /

Specify Build Style and
style configuration parameters
for iSeries Project

This build skyle will upload CL programs specified in the configuration, compile them,
and then run them ko build this praject, The compile commands can be automatically
generated.

more information on next slide ...

Provided by IBM plugin 'iSeriss Tooling - Styles Flugin” version 5.0,0

«&p Command Build Style Configuration
e T R AR R

Enter U e —— WL this project.

<Back e | Ensh | caneel |

Build Command:

™ autematically push all changed members prior ko build
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Here we see the rest of the iSeries Project wizard. First, give the project a
name. Any name you want! Then select or create a connection (from the
RSE!) that identifies the iSeries with which this project is associated. Also
select the library on that iSeries where the contents of this project will be
pushed to. Also, specify a CL command to call for the "Build" action. If you
don't have such a CL command, enter a dummy value or leave it blank.
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iSeries Projects Build Styles

= Build Styles

Specify how to build the iSeries project on the remote system

Three IBM-supplied build styles

CL Program

Automatically generates COMPILE.CLLE and BIND.CLLE
Adds compile command for each source file in project
Uses last compile command from RSE for specified source type
i.e. CRTBNDRPG versus CRTRPGMOD

At build time these two members are pushed to iSeries, compiled and
run

Command
You specify single command to run build
Good if you have an existing build script
*NONE
No build support

= |SVs can plug-in additional build styles
To work with their existing iSeries systems
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Here we see the wizard for creating a new iSeries source physical file.
Within the project, this is actually a folder. When the project is pushed to
its associated library, this result in a CRTSRCPF command being run to
create a file with the attributes specified in this wizard.
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Project "Bleedthrough”
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Dprice s Like(RPrice)
C open CWSTOCK
e
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c Ewal quant = 100
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Here we see an iSeries project in the iSeries Navigator, within the iSeries
Projects perspective, that has a number of local files and members.
Right-clicking on the project or anything in the project, gives a popup menu
with the all-important "Show Remote Objects" menu item....
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Local and Remote Objects

&P iSeries Projects - WebSphere Development Studio Client for iSeries Ise"es Prolecl IIaVI!lallll: L|5|
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@ E-E§ qDDssrq Mo r{oo Dquant .
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L mwEr @oTo 3 & .
El- . »remote objects, files and mbrs
L b nRenote e (00 -Use Add to Project to copy | |
[ T — o from library to project
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P o T2 -
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g P "o (Remote) => |
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g Sroees MR (Local/Remote) => <=> i
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! i CWWSSR Compare With b Push Selected 2| »-conflict between local and remote
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Once "Show Remote Objects" is enabled (it is a toggle) all the objects in
the associated library for this project are shown in the iSeries Navigator.

This navigator is called a "bleed through" view because it lists both local
files/members and remote objects, files and members. However, if a file or
member exists both locally and remotely, it is not shown twice. Rather, it is
only shown once, and its icon and bracketed text identify it as existing in
both places.

The icons and text enable you to see at a glance which files/members
exist only locally, only remotely, or both locally and remotely. In the latter
case, the color of the icon indicates if the two are in synch or not. If not, it
is an indication you need to "push" your local source to the associated
library to get it in synch.
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iISeries Projects Remote Build

= Submit Build
Submits build of iSeries project on remote system
Adds build job to iSeries Build Job Status view

Job where build
is running Status of the build

& iSeries Build Job Stabus ] l @ x

DatefTitme Submitted Job | Project | Status |
30-Mar-D3 9:29:02 PM 923621 /VANTZIVANTZ] WHO Faal F Finished
30-Mar-D3 9:30:08 PH 923623{VANTZLYANTZ] Cance| Queued

Retrieve Errors
Remove

Al _*lRefresh Interval: 10 seconds
X
Refresh interval Retrieve errors from
determines how frequently build to the

status is updated iSeries Error List

;'!J l‘

62 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation

Once "Show Remote Objects" is enabled (it is a toggle) all the objects in
the associated library for this project are shown in the iSeries Navigator.

This navigator is called a "bleed through" view because it lists both local
files/members and remote objects, files and members. However, if a file or
member exists both locally and remotely, it is not shown twice. Rather, it is
only shown once, and its icon and bracketed text identify it as existing in
both places.

The icons and text enable you to see at a glance which files/members
exist only locally, only remotely, or both locally and remotely. In the latter
case, the color of the icon indicates if the two are in synch or not. If not, it
is an indication you need to "push" your local source to the associated
library to get it in synch.
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Remote System Explorer Extension Points
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Additional documentation on the following extension points can be found in

C:\WDSCl\iseries\eclipse\plugins\com.ibm.etools.systems.core_5.0.0\plugin.xml
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Benefits of Building On Top of the RSE

= What does the RSE offer you?
Extension points for remote objects
Popup menus
Property pages
Extend the remote system framework
Add a new subsystem
Add a new system type
iSeries, Linux, Unix, Windows and Local are pre-supplied
Java APIs for accessing remote systems
Native
Retrieve lists of libraries, objects, members and jobs based on filters
Retrieve properties for a library, object, member or job
Prompt and run commands
Run applications in batch or interactive
IFS / Windows / Linux / Unix
Retrieve lists of directories / files
Run remote commands
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Adding a New RSE System Type

= Extension point
com.ibm.etools.systems.core.systemtype

= Adds a new system type to the Remote Systems Framework
The new system type will appear in the new connection wizard
No Java code required!

You can then add new subsystems for this type

<extension point="com.ibm.etools.systems.core.systemtype">
<type name="Windows"
iconlive="icons/windowsL.ive.gif"> icon changes

icon="icons/windows.gif"> when system
9 T is connected
</type>

or
disconnected

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Adding New Subsystems

= Extension point
com.ibm.etools.systems.core.subsystemfactory

A SubSystemFactory creates instances of a specific type of
subsystem

= Adds a new subsystem
New subsystem will appear under connections of specified type

<extension point="com.ibm.etools.systems.core.subsystemfactory">
<factory

systemtypes="iSeries"
name="Files"
icon="icons/filesubsys.gif"
iconlive="icons/filesubsyslive.gif"
id="com.acme.etools.mypkg.myfactory"
class="com.acme.etools.mypkg.MyClass"
category="files"
vendor="acme">

Class must implement the
com.ibm.etools.systems.subsystems.SubSystem
</factory Factory

T interface

Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation
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Adding Property Pages for Remote Objects

= Extension point

com.ibm.etools.systems.core.propertyPages

= Add property pages for remote objects

Property pages will appear in the properties dialog when user selects
"Properties..." from the popup menu for a remote object

<extension point="com.ibm.etools.systems.core.propertyPages">

<page class="com.acme.myPropertyPage"
id="com.acme.mypropertypage"
name="Remote File Info"
icon="icons/myProperties.gif"
subsystemfactoryid="ibm.filesLocal"
typecategoryfilter="files" =]
typefilter="file"
subtypefilter="java"
namefilter="*_java">

Add you own tools | Eclipse Plug-in Development

~-Filters are subsystem specific
~-Each remote object can have a
type, subtype and subsubtype
~-For example

*Type: *PGM

*Subtype: RPGLE

~-Can also filter by name

© 2003 IBM Corporation
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Adding Popup Menu Actions for Remote Objects

= Extension point
com.ibm.etools.systems.core.popupMenus

= Add action for remote objects

New action will appear in the popup menu of remote objects in the
Remote Systems view

Example —>

% |
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Adding Popup Menu Actions for Remote Objects

<extension point="com.ibm.etools.systems.core.popupMenus">
<objectContribution
id="com.acme.displayfile.actions"
subsystemfactoryid="ibm.files400"
typecategoryfilter="OBJECT*"

typefilter="*FILE"
subtypefilter="DSPF" Same as property
namefilter pages
<menu id="com.acme.dis|
label="My Display File Actions">
W Adds the

<separator name="group1"/>

</menu> menu item

<action id="com.acme.action1"
label="My first action"
class="com.acme.actions.Action1"
menubarPath="com.acme.displayfile.menu/group1"
enablesFor="1">

</action>

<action id="com.acme.action2"
label="My second action"
class="com.acme.actions.Action2"
menubarPath="com.acme.displayfile.menu/group1"
enablesFor="+">

</action>

</objectContribution>

Your actions
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SoftLanding Systems, Inc.

4P Remote System Explorer - 1BM WebSphere Studio Application Developer

Fle Edit Mavigate Search Project Run Window Help

Free Spooled File Plug-in for
WDSC, includes:

- Spooled files subsystem
- Spool files filtering

= Lo || S [I%-%-] 7 [ %- - -
- Spooled files table view
iz w x || ] ORDENTR_941573_VANTZI_QPRTIOB_I.txt XI
ERPE e - (P L I VIR - Perform remote actions on
&) SLESERM s H
B[ Q e B | - spooled files
i serles Obfects Issued by FANTZI
&% iSeries Commands
B i5eries Jobs Program CORDENTR
T, IFS Files
88 iSeries Spocled Files Library DEMODY
= -
Bl Vour spoaled files Text 'description’ *SRCHBRTET
i G 3
B OFFLINE,— — "
QFFLTE, 65 mofresh bexr ORDENTR
B OFFLINE Expand e QRPGLESRC
B oFRLINE [ e
B oOFFINE._ — DEMODY
OFFLINE: sy oo o
B OFFLINE =
B oFrLine: % Delete | - - - : =|
OFFLINE.
OFFLINE, S b= PR x
B OFFLINE Save to Fil
B OFFLINE aavetofie...
OFFLINE: Change
OFFLINE: Mave
T
Remote Systems | Taam g ligw |iSeries Commands Log |Properties {SearchJ
—— R L ‘ www.softlanding.com
Messages(E

7 Add you own tools | Eclipse Plug-in Development

© 2003 IBM Corporation




‘ IBM Software Group | WebSphere software

SoftLanding Systems, Inc.

Spooled File Filter

Create a new filer to list spocled files

User; B

output queue: [
Library: B

User data: *

Form type: *

Define your own filters for
showing spooled files

co | me> | Enen

| coneel |
v x
Device or Queus Status es | CurrentP... | User [ 308 File: Mumb ~
RDEMTR QGPL/QPRINT FREADY o VANTZL QPADEVD 917371 1
OFFLINE1A QGPLIQPRINT FREADY o YAMTZI QPADEVD... 917406 1
OFFLINE1A QGPLIQPRINT FREADY 3 o YAMTZL QPADEVD... 917406 2 —
OFFLINE1A QGPLIQPRINT HREADY 3 o VAMTZL QPADEVD 917406 3
OFFLINE1A QGPLIQPRINT FREADY 3
OFFLINE1A QGPLIQPRINT FREADY 3
OFFLINELA  QGPLIQPRINT *READY 3 . . ;
A3 ZREY___L3 Spooled files view shows details
Tasks |Series Table iew |Series Commands Log | Praperties |search | spocked Fles| — @looUt each SpOOl f||e and provides

y ) right click popup menu actions
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Summary

= Eclipse and the WebSphere Studio Workbench provide:
An integrated development environment
Extendable platform

You can focus on your function without worrying about:
Resource management
Help system

Rich set of base classes for quickly developing Ul

= WDSc provides:
iSeries tooling plugged into Eclipse

Remote Systems Framework

With extension points so you can add functionality to the RSE

74 Add you own tools | Eclipse Plug-in Development © 2003 IBM Corporation




‘ IBM Software Group | WebSphere software

Additional Resources
= Eclipse
www.eclipse.org

= WebSphere Development Studio Client
http://www.ibm.com/software/awdtools/iseries//

= |BM’s developerWorks
www.ibm.com/developer
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Disclaimer

= Acknowledgement:
This presentation is a collaborative effort of the IBM Toronto AS/400 Application
Development presentation team, including work done by:

Phil Coulthard, George Farr, Claus Weiss, Don Yantzi, John Steinbacher,
David Slater, Alison Butteril, Linda Cole
= Disclaimer:

The information contained in this document has not been submitted to any formal
IBM test and is distributed on an as is basis without any warranty either express
or implied. The use of this information or the implementation of any of these
techniques is a customer responsibility and depends on the customers' ability to
evaluate and integrate them into the customers' operational environment. While
each item may have been reviewed by IBM for accuracy in a specific situation,
there is no guarantee that the same or similar results will result elsewhere.
Customers attempting to adapt these techniques to their own environment do so
at their own risk.

= Reproduction:

The base presentation is the property of IBM Corporation. Permission must be
obtained PRIOR to making copies of this material for any reason.
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